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Animations in Creo 3.0  ME170  

  

Part I.  Introduction & Outline  

Animations provide useful demonstrations and analyses of a mechanism's motion. This document 

will present two ways to create a motion animation in Creo: one method utilizes snapshots, the 

second method uses servo motors in Creo's Mechanism package. The snapshot method is 

arguably the easier of the two. However, the latter method creates a smoother animation.   

In order to create and capture a mechanism's motion in an animation, we must first define 

connections that permit the movement (translation or rotation) of parts. This connection 

definition occurs in the assembly. The electronic dongle was assembled entirely with rigid 

constraints, which do not permit any motion. However, Cero can accommodate numerous motion 

connections. A list of Creo's motion connections is shown below.  

  

The pin connection and slider connection are the two simplest and most common mechanism 

connections. This document provides instructions for creating each connection. The ME 170 

term project instructions state that you must have at least one motion axis in your final project. 

Your  motion axis does not have to be a pin-type or a slider-type. These two connection 

instructions are provided solely as a reference.  

The outline of this document is as follows:  

• Pin Connection Definition  

• Slider Connection Definition  

• Animation with Snapshots  

• Animation using a Servo Motor  

Additional information on joint connections, Creo's mechanism capabilities, animations, and 

motion analyses can be found in the "Joint Connection, Mechanism, & Animation Reference" 

document on the ME 170 course website.  
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Part II.  Pin Connection Definition  

1) Assemble and fully constrain the first part(s) of your assembly.  

A "Default" constraint is recommended for the first component of every assembly. This fixes 

the first part in place. Before defining a joint or motion connection, a fixed, fully-constrained 

part is needed to serve as a fixed reference.  

  

2) Click the "Assemble" button to assemble a new component.  

  

3) Select the component you would like to assemble and click "Open."  

4) Select a "Pin" connection from the motion connection drop-down menu.  

  

5) Open the "Placement" tab in the assembly ribbon. This will help guide you through the 

definition of the connection (image below).  
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6) Notice that the connection definition is asking for "Axis alignment" references. 

Consequently, we will first select the axes to align.  

7) Select the rotation axis for the pin connection. Note that a cylindrical surface, the axis of a 

coordinate system, and an actual axis can all be used to define a rotation axis. In the image 

below, the inner cylindrical surfaces of the hinge have been selected.  

  

8) After selecting the rotation axes, go back to the "Placement" tab in the assembly ribbon 

(image below). Notice that Creo now requests that we select "Translation" constraints.  

The pin connection in Creo does not permit translational motion. It only permits rotation 

around one axis. It is a single degree-of-freedom (1 DOF) connection. The translation 

constraint is used to align the rotating components along the rotation axis.  
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9) Select two planes or surfaces normal to the motion axis to serve as translational alignment 

constraints. Note that an offset or distance value can be specified for the translation 

constraint, so the planes or surfaces do not need to be coincident. In the hinge example, two 

mating surfaces have been selected to be coincident.  
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10) Go back to the "Placement" tab on the assembly ribbon. Click on "Rotation Axis" to define 

additional useful parameters for the hinge.  

The parameters under the "Rotation Axis" heading govern the regeneration value and 

minimum, and maximum limits of motion for the hinge. If these parameters are not defined, 

Creo will permit unrealistic motion of the component such as that shown in the image below.  

  

11) Select two planes to serve as angular references for the regen value and max and min limits 

of motion. The two upper surfaces of the hinge have been selected as shown in the image 

below.  

12) Double click the angle in the model window and specify a regeneration value. Click the 

middle mouse button to confirm the new value. An angle of "90.00" has be specified in the 

image below. However, "90" was insufficient. The angle had to be adjusted to "-90" to yield 

a physically-feasible orientation.  

  

13) Click the ">>" button in the "Placement" tab to set the current position as the regeneration 

position (image below).  
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14) Click the "Enable regeneration value" checkbox to enable a regeneration value. If necessary 

(if required by your design), specify minimum and maximum limits of motion and check the 

checkboxes to enable these constraints.  

  

15) Click the green checkmark to confirm your joint connection.  

  

16) Move your newly assembled component by holding CTRL+ALT and clicking and dragging 

the component. Notice that the motion will stop at the defined minimum and maximum 

limits. If you have defined a regeneration value, click regenerate or type CTRL+G to 

regenerate the model to return the model to its base state.  

17) NOTE: Pay particular attention to your assembly references when assembling components. 

Additional components which are assembled with references to moving components, may 

themselves become moving components.  
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Part III. Slider Connection Definition  

1) Click the "Assemble" button to assemble a new component.  

  

2) Select the component you would like to assemble and click "Open."  

  

3) Open the "Placement" tab in the assembly ribbon. This will help guide you through the 

definition of the connection.  

Notice that the connection definition is asking for "Axis alignment" definition. Consequently, 

we will first select the motion axes to align.  
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4) Select the motion axis for the slider connection. This is the axis along which the two 

components will slide. Note that a cylindrical surface, the axis of a coordinate system, and an 

actual axis can all be used to define a motion axis. In the image below, the inner cylindrical 

surface of the pneumatic cylinder and the outer cylindrical surface of the shaft have been 

selected.  

  

5) After selecting the rotation axes, go back to the "Placement" tab in the assembly ribbon. 

Notice that Creo now requests that we select "Rotation" constraints.  

The slider connection in Creo does not permit rotational motion. It only permits translation 

along one axis. It is a single degree-of-freedom (1 DOF) connection. The rotation constraint 

is used to align the translating components along the translation axis.  

  

6) Select two planes or surfaces parallel to the translation axis to serve as rotational alignment 

constraints (image below). These two planes or surfaces will be constrained to be oriented 

parallel to one another. An offset angle cannot be specified for this rotation constraint. In this 

example, flat surfaces on the piston and the cylinder have been selected.  

Note that this is not a particularly realistic constraint for a pneumatic cylinder. The piston of 

a pneumatic cylinder is typically free to rotate about its translation axis. Consequently, Creo's 

"Cylinder" motion connection would be more appropriate. However, for the purposes of this 

example, the pneumatic cylinder will suffice.  
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7) Go back to the "Placement" tab on the assembly ribbon. Click on "Translation Axis" to 

define additional useful parameters for the slider connection.  

The parameters under the "Translation Axis" heading govern the regeneration value and 

minimum, and maximum limits of motion for the slider connection. If these parameters are 

not defined, Creo will permit unrealistic motion of the component such as a piston that 

moves beyond its mechanical stops in the pneumatic cylinder.  

  

8) Select two planes or surfaces to serve as translation references for the regen value and max 

and min limits of translational motion. These two planes or surfaces should be normal to the 

axis of motion. The top surfaces of the piston and cylinder have been selected for this 

example.  
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9) Double click the distance in the model window and specify a regeneration value. Click the 

middle mouse button to confirm the new value. An distance of "1.00" has be specified in the 

image below.  

  

10) Click the ">>" button in the "Placement" tab to set the current position as the regeneration 

position.  

  

11) Click the "Enable regeneration value" checkbox to enable a regeneration value. If necessary 

(if required by your design), specify minimum and maximum limits of motion and check the 

checkboxes to enable these constraints.  

  
12) Click the green checkmark to confirm your joint connection.  
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13) Move your newly assembled component by holding CTRL+ALT and clicking and dragging 

the component. Notice that the motion will stop at the defined minimum and maximum 

limits. If you have defined a regeneration value, click regenerate or type CTRL+G to 

regenerate the model to return the model to its base state.  

NOTE: Pay particular attention to your assembly references when assembling components. 

Additional components which are assembled with references to moving components, may 

themselves become moving components.  
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Part IV. Animation with Snapshots  

1) In order to create an animation with snapshots, we must first create the snapshots that we will 

use for the animation. Open the assembly that you would like to animate. Your assembly 

should be fully assembled, appropriately colored, and the appropriate motion connections 

should be defined.  

2) Navigate to the "Model" ribbon and click the "Drag Components" icon.  

  

3) In the new window on the right side of the screen, click the arrow next to "Snapshots" to 

expose the Snapshots window.  

  

4) Click and drag your component to the first position of your animation. Note that you will 

only be able to record 10 frames for your snapshot animation. It is possible to create multiple 

animations if one does not adequately demonstrate the functionality of your part.  

5) Once your component is in position, click the "Take a Snapshot" button in the "Drag" 

window (image below).  

  

6) Click and drag your assembly to a new orientation. Take multiple snapshots of your 

component to use for your animation. You can delete snapshots by right clicking on them and 

selecting "Delete" in the "Drag" window.  
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7) Once you have enough snapshots (10 max for the particular animation), close the "Drag" 

window.  

8) To begin an animation, navigate to the "Applications" tab and click the "Animation" icon.  

  

9) Click the "New Animation" drop-down menu and select "Snapshot".  

  

10) Specify a name for your animation and click "OK" (image below).  

  

11) Click the "Key Frame Sequence" icon on the top ribbon to create a new frame sequence.  
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12) Populate your animation with snapshots by selecting a snapshot, specifying the time, and 

clicking the "+" button. Note that the time will increment automatically by 1 second each 

time you add a snapshot to the animation. The one-second-per-snapshot baseline is good for 

timing.  

13) Change the interpolation buttons from "Linear" to "Smooth" to increase the production 

quality of your animation (image below).  

  

14) Click "OK" to close the "Key Frame Sequence" window.  

15) Press the "Generate" button, shown below, to generate your animation.  
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16) Click "Playback" to go to the animation playback controls.  

  
17) Play your animation a few times to confirm it is correct.  

18) If you would like to shorten the length of your animation, navigate back to the "Create" 

controls. Click the "Time Domain" button on the top ribbon, and specify a end time.  

  

19) Click "OK" to cloes the "Animation Time Domain" box. Click the "Generate" button to 

rebuild your animation. Navigate back to the "Playback" controls to watch your animation.  

20) To save the animation, first save your assembly in Creo (File > Save or CTRL+S). Click the 

"Capture" buttons in the "Playback" controls area.  
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21) Specify a name and parameters for your video file (image below).  

  

22) Your video file will be saved to your working directory.  
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Animations in Creo 3.0 ME170 

Part V. Creo Mechanism 

This plugin allows the user to run motion analysis on assemblies. Instead 

of using 3
rd

 party software, an assembly can be directly imported into 

Mechanism and analyzed. Features like springs and dampers can have 

real life properties assigned to make the model as accurate as possible. 

Along with showing you the actual animation of your assembly, Creo 

Mechanism can output position, velocity, acceleration and even force 

data for any point in the assembly.  

The following pages will go over the basics of Creo Mechanism to help 

you constrain and successfully animate your model. Parts must be 

constrained together with mechanism connections before a full analysis 

can be run. 

Start by opening up the Mechanism plugin. 

 

You will see that there are a lot of options to change when setting up a 

mechanism. The Mechanism ribbon, shown below, is where all of the 

setup and analysis is configured. 
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Animations in Creo 3.0 ME170 

Cams 

Cam connections can be made by selecting the Cams button located on 

the Mechanism ribbon. The Cam Follower Connection Definition 

dialog box will pop up with the Cam 1 page selected.  

  

 

 

  

I. The Cam 1 page is used to 

setup the cam and the Cam 

2 page is used to setup the 

follower. 

II. The Surfaces/Curves 

selection box is used to 

select the contact surfaces 

between the cam and the 

follower.  

a. Creo will 

automatically find 

tangent surfaces to 

the selection when 

Autoselect is used. 

III. Creo will require extra 

references for flat surfaces. 

These references will need 

to be set using the Depth 

Display Settings located 

below the initial surface 

selection.  

a. A flat surface will 

require a front and 

back reference point 

or vertex. 

IV. The Properties tab allows 

friction and liftoff to be 

enabled. If liftoff is 

selected, the follower can 

lift off from the cam during 

its range of motion. 
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Animations in Creo 3.0 ME170 

Gears – Generic 

Gear connections can be made by selecting the Gears button located on 

the Mechanism ribbon. The Gear Pair Definition dialog box will pop 

up with the Gear1 page selected.  

  

 

 

  

I. The Type dropdown box is 

used to select the gear pair 

type. The options are a 

generic gear pair, spur gears, 

bevel gears, worm gears and 

rack and pinion set. 

II. The Generic setting can be 

used for straight gear sets 

along with the following 

three pairs of joint axes 

a. Rotation-Rotation 

b. Rotation-Translation 

c. Translation-Translation 

III. The Motion Axis selection 

box is used to select the axis 

of rotation for each gear. 

a. Enter the Pitch Circle 

Diameter for if the joint 

axis is rotation 

b. Enter the Gear Ratio 

under the Properties 

tab if the motion is 

translational 
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Animations in Creo 3.0 ME170 

Gears – Spur 

Gear connections can be made by selecting the Gears button located on 

the Mechanism ribbon. The Gear Pair Definition dialog box will pop 

up with the Gear1 page selected.  

  

 

 

  

I. The Type dropdown box is 

used to select the gear pair 

type. The options are a 

generic gear pair, spur gears, 

bevel gears, worm gears and 

rack and pinion set. 

II. The Spur setting is used 

when the pressure angle and 

helix angle are required. The 

joint axes must also be 

parallel. 

III. The Motion Axis selection 

box is used to select the axis 

of rotation for each gear. 

a. Enter the Pitch Circle 

Diameter for Gear 1 

b. The Pitch Circle 

Diameter will 

automatically calculate 

for gear 2 

IV. The Helix Angle and 

Pressure Angle are set using 

the properties page 

V. A preview of the gear is 

created 
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Animations in Creo 3.0 ME170 

Gears – Bevel 

Gear connections can be made by selecting the Gears button located on 

the Mechanism ribbon. The Gear Pair Definition dialog box will pop 

up with the Gear1 page selected.  

  

 

 

  

I. The Type dropdown box is 

used to select the gear pair 

type. The options are a 

generic gear pair, spur gears, 

bevel gears, worm gears and 

rack and pinion set. 

II. The Bevel setting is used 

when the center axes of both 

gears intersect. Gear teeth for 

bevel gears are conically 

shaped. 

III. The Motion Axis selection 

box is used to select the axis 

of rotation for each gear. 

a. Enter the Pitch Circle 

Diameter for Gear 1 

b. The Pitch Circle 

Diameter will 

automatically calculate 

for gear 2 

IV. The Helix Angle and 

Pressure Angle are set using 

the properties page 

V. A preview of the gear is 

created 
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Animations in Creo 3.0 ME170 

Gears – Worm 

Gear connections can be made by selecting the Gears button located on 

the Mechanism ribbon. The Gear Pair Definition dialog box will pop 

up with the Gear1 page selected.  

  

 

  

I. The Type dropdown box is 

used to select the gear pair 

type. The options are a 

generic gear pair, spur gears, 

bevel gears, worm gears and 

rack and pinion set. 

II. The Worm setting is used 

when an assembly contains a 

worm screw gear driving a 

worm wheel gear. 

III. The Motion Axis selection 

box is used to select the axis 

of rotation for the worm and 

wheel. 

a. Enter the Pitch Circle 

Diameter for the worm. 

b. The Pitch Circle 

Diameter will 

automatically calculate 

for the wheel 

IV. The Helix Angle and 

Pressure Angle are set using 

the properties page 

V. A preview of the gear is 

created 
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Animations in Creo 3.0 ME170 

Gears – Rack and Pinion 

Gear connections can be made by selecting the Gears button located on 

the Mechanism ribbon. The Gear Pair Definition dialog box will pop 

up with the Gear1 page selected.  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

I. The Type dropdown box is 

used to select the gear pair 

type. The options are a 

generic gear pair, spur gears, 

bevel gears, worm gears and 

rack and pinion set. 

II. The Rack and Pinion option 

is chosen when a normal gear 

is meshed together with a 

gear constrained as a slider. 

III. The Motion Axis selection 

box is used to select the axis 

of rotation for the pinion and 

the translation axis for the 

rack. 

a. Enter the Pitch Circle 

Diameter for the 

pinion. 

IV. The Helix Angle and 

Pressure Angle are set using 

the properties page 

V. A preview of the gear is 

created 
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Animations in Creo 3.0 ME170 

Springs – Extension/Compression 

Spring can be added by selecting the Springs button located on the 

Mechanism ribbon.  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

I. To add a spring, click on the Springs button on the Insert tab. 

Make sure you turn on Point Display to show datum points. A 

spring requires a top and bottom datum point or a translational 

axis to constrain it. 

II. For the point method, select the point corresponding to the top of 

the spring and then hold CTRL and select the bottom point of the 

spring to complete it 

III. When creating a spring along a translation axis, the spring length 

must be set using the references tab.  

a. Points or vertices can be used to set the spring length by 

selecting the Custom option in references. 

b. The spring length can also be constrained to start at the 

initial, or zero, position of the translational axis by selecting 

the Use motion axis zero option 

IV. The spring definition ribbon allows the user to change the spring 

stiffness, the stiffness units and the free length.  

V. The visual diameter of the spring can be changed by using the 

Adjust Icon Diameter under the options tab in the spring 

definition ribbon. This has no physical effects. 
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Animations in Creo 3.0 ME170 

Springs – Torsion 

Springs can be added by selecting the Springs button located on the 

Mechanism ribbon.  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

I. To add a torsion spring, click on the Springs icon on the Insert 

tab. Then click on the Torsion Spring button to the left of the 

green reference box. A torsion spring requires a rotation axis to 

constrain it. 

II. When creating a spring along a rotational axis, the spring angle 

must be set using the references tab.  

a. Planar surfaces can be used to set the spring angle by 

selecting the Custom option in references. 

b. The spring angle can also be constrained to start at the 

initial, or zero, position of the rotational axis by selecting 

the Use motion axis zero option 

III. The spring definition ribbon allows the user to change the spring 

stiffness and the stiffness units. 

IV. The visual diameter of the spring can be changed by using the 

Adjust Icon Diameter under the options tab in the spring 

definition ribbon. This has no physical effects. 
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Animations in Creo 3.0 ME170 

Damper – Extension and Compression 

Dampers can be added by selecting the Dampers button located on the 

Mechanism ribbon.  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

I. To add a damper, click on the Damper icon on the Insert tab. 

Make sure you turn on Point Display to show datum points. A 

damper requires a top and bottom datum point or a translational 

axis to constrain it. 

II. For the point method, select the point corresponding to the top of 

the damper and then hold CTRL and select the bottom point of the 

damper to complete it 

III. When creating a damper along a translation axis, simply select the 

axis. 

IV. The damper definition ribbon allows the user to change the 

damping rate and its units.  
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Animations in Creo 3.0 ME170 

Damper – Torsion 

Dampers can be added by selecting the Dampers button located on the 

Mechanism ribbon.  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

I. To add a torsion damper, click on the Damper icon on the Insert 

tab. Then click on the Torsion Damper button to the left of the 

green reference box. A torsion damper requires a rotation axis to 

constrain it. 

II. The damper definition ribbon allows the user to change the 

damping rate and the damping rate units. 
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Animations in Creo 3.0 ME170 

Servo Motors 

Servo motors move the mechanism according to a user specified profile. 

Servo motors do not take friction, mass or other parameters into account, 

they just move the model.  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

I. To add a servo motor click on the Servo Motors icon on the 

Insert tab. 

II. A definition window will open up and ask you to select a motion 

axis. Select the motion axis that you want to animate. 

III. The Profile tab in the definition window can be used to specify 

the desired motion profile. A constant velocity profile is arguably 

the simplest motion profile for an animation. However, 

acceleration and position profiles can also be specified with 

constant, linear, parabolic, sinusoidal and user define functions. 

IV. You can graph the position, velocity, and acceleration profiles for 

your components by selecting the appropriate check boxes and 

clicking the Graph icon in the lower part of the dialog box. These 

graphs are quite useful when working with and troubleshooting 

more complex motion profiles. 
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Animations in Creo 3.0 ME170 

Force Motors 

Force motors move the mechanism according to a user specified profile. 

Force motors take mass into account. A dynamic or force analysis will 

only run if mass properties are defined for every part in the mechanism.  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

I. To add a force motor click on the Force Motors icon on the 

Insert tab. 

II. A definition window will open up and ask you to select a motion 

axis. Select the motion axis that you want to animate. 

III. The same definition window can be used to specify the desired 

motion profile. A constant profile is arguably the simplest motion 

profile for an animation. However, profiles can also be specified 

with constant, linear, parabolic, sinusoidal and user define 

functions. 

IV. You can graph the magnitude and derivative profiles for your 

components by selecting the appropriate check boxes and clicking 

the Graph icon in the lower part of the dialog box. These graphs 

are quite useful when working with and troubleshooting more 

complex motion profiles. 
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Animations in Creo 3.0 ME170 

Mechanism Tree 

Similar to the Model Tree, the Mechanism Tree is used to edit the 

mechanism’s features. Motors, connections, spring and other parameters 

can be accessed and modified from this tree. 
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Animations in Creo 3.0 ME170 

Mass Properties 

Mass properties are important for applications that require a dynamic or 

static analysis. For these analyses to work, all bodies need to have a 

mass associated with them. The user can set the mass properties in 

multiple ways when using the mechanism application. 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

I. Mass properties can be setup when creating a part in Creo Parametric. 

It is good practice to set your mass properties when creating each part. 

II. Mass properties can also be setup while in the mechanism application. 

Any mass properties setup while in the mechanism application will 

take priority over mass properties setup elsewhere in Creo. 
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Animations in Creo 3.0  ME170  

 

 

I. Click on the Mass Properties button located on the Properties and 

Conditions tab 

II. Select the reference type. This menu allows you to set the mass 

properties of a specific part or an assembly. The body option only 

allows you to view the mass properties of a body, not edit them. 

III. The Define properties by menu selects the properties to be defined.  

a. The Default option uses the mass properties set in Creo 

Parametric 

b. The Density option allows the user to set a density that will 

override the Creo Parametric density 

c. The Mass Properties option allows the user to manually set the 

mass, center of gravity and inertia values. 
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Animations in Creo 3.0 ME170 

Gravity 

Gravity can be setup for use in dynamic and static analyses. 

 

 

  

 

 

 

 

 

 

 

 

  

I. Click on the Gravity button to open up the gravity definition window. 

II. The gravity definition window allows the user to setup the magnitude 

and direction.  

III. The X, Y and Z options follow the default coordinate system of the 

mechanism. 

IV. Gravity is turned on and off in the analysis setup. It is located on the 

External Loads page of a Dynamic, Static or Force Balance analysis.   
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Animations in Creo 3.0 ME170 

Snapshot 

Snapshots of the mechanism can be taken and used as the initial 

configuration for an analysis. This is a useful tool to start at the same 

initial position for multiple analyses.  

 

 

  

 

 

 

 

 

 

  

I. Start by clicking the Drag Components button. 

II. Click on the white arrow to open the snapshot options.  

III. Clicking the camera icon under Current Snapshot will record a 

snapshot of the current mechanism position.  

IV. Use the options on the left side of the Drag Components definition 

window to modify the snapshot.   
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Animations in Creo 3.0 ME170 

Mechanism Analysis 

The actual animation of the mechanism is done through a Mechanism 

Analysis.  

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

I. Click on the Mechanism Analysis button located on the Analysis tab. 

II. The analysis definition window will open up. This definition window 

is used to select the type of analysis, along with the start time, end 

time, frame rate and initial configuration.  

III. The Initial Configuration can be setup to use the mechanism’s 

current position, or setup to use a premade snapshot of the mechanism. 
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Mechanism Analysis 

To create a basic animation, a position or kinematic analysis is 

recommended. Static, dynamic and force balance analysis require mass 

properties to run, while a position or kinematic analysis will run without 

those setup. 

Once the type of analysis is selected, the motors to move the model must 

be setup. 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

I. The Motors tab is used to specify which motors will run the 

analysis. For the position and kinematic analysis, only the servo 

motor will be listed. 

II. Dynamic, Static and Force Balance analysis can also use force 

motors. When running these analyses, both force and servo motors 

will be listed in the motors tab. It is important to remove motors if 

they are not required as they can “fight” each other if setup 

incorrectly. 

III. Use the buttons to the right of the motors to add or delete motors. 

IV. The External Load tab can be used to setup external user defined 

loads and can also be used to turn on friction and gravity. 
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Playback 

The Playback button can be used to playback the animation of any 

analysis and also export it as a video. 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

I. Click on the Playback button located on the Analysis tab. 

II. Select your desired Result Set and click the Play Current Result Set 

button located to the left of the folder icon. 

III. Click the Capture button to export the animation as a video.  

IV. Clicking capture opens up the Capture Definition window. This 

window can be used to rename your video and change its resolution 

and frame rate. Click OK when finished to start the export process.  

 


